# Racket Notes–Chapters I-VII–Fall 2016

Original by Luke Hunsberger (modified by Jenny Walter)

## CONTENTS

<p>| I | Introduction | 2 |</p>
<table>
<thead>
<tr>
<th>II</th>
<th>Primitive Data Types</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>II-A</td>
<td>Numeric Type</td>
<td>3</td>
</tr>
<tr>
<td>II-B</td>
<td>(Quoted) Symbol Type</td>
<td>4</td>
</tr>
<tr>
<td>II-C</td>
<td>Image Type</td>
<td>4</td>
</tr>
<tr>
<td>II-D</td>
<td>Boolean Type</td>
<td>5</td>
</tr>
<tr>
<td>II-E</td>
<td>String Type</td>
<td>5</td>
</tr>
<tr>
<td>II-F</td>
<td>Character Type</td>
<td>6</td>
</tr>
<tr>
<td>II-G</td>
<td>Void Type and Side Effects</td>
<td>7</td>
</tr>
<tr>
<td>II-H</td>
<td>Built-in Function Names</td>
<td>7</td>
</tr>
<tr>
<td>II-I</td>
<td>Empty List Type</td>
<td>8</td>
</tr>
<tr>
<td>II-J</td>
<td>Non-empty List Type</td>
<td>8</td>
</tr>
<tr>
<td>III</td>
<td>Writing Programs in DrRacket</td>
<td>10</td>
</tr>
<tr>
<td>III-A</td>
<td>Expression Evaluation</td>
<td>11</td>
</tr>
<tr>
<td>III-B</td>
<td>The Global Environment</td>
<td>11</td>
</tr>
<tr>
<td>III-C</td>
<td>Evaluation of Primitive Data</td>
<td>12</td>
</tr>
<tr>
<td>III-D</td>
<td>Evaluation of Primitive Functions</td>
<td>13</td>
</tr>
<tr>
<td>III-E</td>
<td>Evaluation of Mathematical Expressions</td>
<td>13</td>
</tr>
<tr>
<td>III-F</td>
<td>Evaluation of Non-Empty Lists (the Default Rule)</td>
<td>16</td>
</tr>
<tr>
<td>III-G</td>
<td>Comments/Documentation</td>
<td>18</td>
</tr>
<tr>
<td>III-H</td>
<td>Indentation, Code Coloring, and Line Length</td>
<td>18</td>
</tr>
<tr>
<td>IV</td>
<td>Defining Variables and Functions</td>
<td>19</td>
</tr>
<tr>
<td>IV-A</td>
<td>Creating named identifiers in the global environment using define</td>
<td>19</td>
</tr>
<tr>
<td>IV-B</td>
<td>Using the define special form to create named functions</td>
<td>21</td>
</tr>
<tr>
<td>IV-C</td>
<td>Creating Functions Using the Lambda Special Form</td>
<td>22</td>
</tr>
<tr>
<td>IV-D</td>
<td>Semantics of λ Expression</td>
<td>23</td>
</tr>
<tr>
<td>IV-E</td>
<td>Unnamed λ Expressions</td>
<td>23</td>
</tr>
<tr>
<td>IV-F</td>
<td>Summary of evaluating λ expressions</td>
<td>24</td>
</tr>
<tr>
<td>IV-G</td>
<td>Local versus Global Environment</td>
<td>24</td>
</tr>
<tr>
<td>V</td>
<td>Displaying Strings within Programs</td>
<td>26</td>
</tr>
<tr>
<td>V-A</td>
<td>The printf, display, and newline functions</td>
<td>26</td>
</tr>
<tr>
<td>V-B</td>
<td>Using printf with escape characters</td>
<td>26</td>
</tr>
<tr>
<td>V-C</td>
<td>Multiple expressions in Racket function body: The begin special form</td>
<td>27</td>
</tr>
</tbody>
</table>
I. Introduction

Most kinds of communication are based on some kind of language, whether written, spoken, drawn or signed. To be used successfully, the syntax and semantics of a language must be understood.

- The syntax rules of a language specify the legal words, expressions, statements or sentences of that language.
- The semantic rules of a language specify what the legal words, expressions, statements or sentences mean.

For example, the syntax rules of the English language tell us that person, tall, told, the, a, me and joke are legal words, and that The tall person told me a joke is a legal sentence, whereas pkrs, shrel and fdadfa are not legal words, and Person tall told a me the is not a legal sentence. The semantic rules tell us what each of the words mean (e.g., what objects the nouns denote and what processes the verbs convey), as well as what the entire sentence means (i.e., that a particular tall person told me a joke). In a similar way, people use a programming language to communicate with a computer. And each programming language has an associated set of syntax rules that specify the legal expressions (or statements or sentences or programs) that can be used in that language, and a set of semantic rules that specify what the legal expressions mean (i.e., what computations the computer will perform). For most computer programming languages, the constituents of the language, whether they are called expressions, statements or entire programs, are usually sequences of typewritten characters.

Although people can effectively communicate using the English language based on an informal, imprecise, intuitive understanding of its syntax and semantics, trying to program a computer based on an informal, imprecise, intuitive understanding of the syntax and semantics of a given programming language typically leads to trouble. Therefore, it is important to be explicit about the syntax and semantics of the programming language being used. Indeed, while programming, it is extremely helpful to have a mental model of the computations the computer is performing. To enable us to enter the world of programming as quickly and painlessly as possible, it is helpful to use a programming language for which the syntax and semantic rules are relatively simple. Racket is just such a language.

Most computer languages display two types of error messages when a program is translated from a high level language like Racket into something the machine can read (in all 1’s and 0’s):

1) syntax error messages are displayed when either illegal words or expressions are evaluated and
2) runtime error messages are displayed when, for example, functions receive the wrong type or number of arguments.

You will undoubtably have lots of experience with error messages during this course, but keep in mind that errors help you learn.

Note: Racket programs are made up of keywords, variables, structured forms, data values (numbers, characters, strings, vectors, quoted lists, quoted symbols, etc.), whitespace, and comments. The next section presents the legal key sequences to represent different data in Racket.
II. Primitive Data Types

Any program in Racket is a sequence of characters. The syntax rules of Racket tell us which character sequences are legal to use in programs. These character sequences are known as “valid” or “legal Racket expressions”. The programming software package we will use for creating programs is called DrRacket.

→ Each Racket program consists of one or more valid Racket expressions. For example, as you’ll soon discover, the following are legal expressions in Racket: 3, true, #t, and ’().

→ A primitive datum is a valid Racket expression that is in simplest form.

In Racket, each legal expression denotes a datum (i.e., a piece of data). The semantic rules of Racket tell us which datum each legal expression denotes. For example, in Racket, the legal expressions 3, #t, and ’(), respectively, denote the number three, the truth value true, and the empty list.

We begin with primitive data expressions. Each primitive data expression denotes a Racket datum of a particular kind. The universe of Racket data is populated by numbers, truth values (called booleans), quoted symbols, lists, characters, strings, among many others. Importantly, each datum has a unique data type. For example, a Racket datum might be a number or a boolean, but it cannot be both. Stated differently, the universe of Racket data is partitioned according to data type and an item of a particular data type can only evaluate to itself. The primitive data types are introduced in parts A–J, in no particular order, below.

In the following sections describing each primitive type, we give the characters that you would type to create primitive data literals, actual values of each data type. After each new primitive data type is introduced, some primitive function names that consume each type are given, along with a sample listing from the on-line help desk. One of the first things you need to know to be successful in this class is how to find and use built-in functions. You are encouraged to look these function names up in the on-line help system in DrRacket.

A. Numeric Type

Characters that represent numbers: According to the syntax rules of Racket, character sequences such as 3, -44, 34.9 and 85/6 are legal Racket expressions. According to the semantics of Racket, these expressions denote the numbers three, negative forty-four, thirty-four point nine and eighty-five sixths, respectively. Each number is an example of a Racket datum and each is also an example of what computer scientists call a “literal value”, meaning the character sequence cannot be used as a placeholder for different values–each evaluates only to itself.

Racket numbers include exact and inexact integers, rationals, reals, and complex numbers. Exact integers and rational numbers have arbitrary precision, i.e., they can be of arbitrary size. Inexact numbers are preceded by #i. Leading 0’s on numbers are dropped.

Functions that consume numbers: Racket’s syntax rules for numerical expressions are quite similar to those for numerical expressions you’ve seen in math classes. The primitive functions that consume numbers include all the ones you’re already used to, such as +, -, *, /, =, >=, >, <=, <, and many more. In programming languages, the +, -, *, and / operators are arithmetic functions that consume numbers and return numbers and the =, >=, >, <=, and < operators are logical operators that consume numbers and return either true or false (booleans).

A version of the Help Desk entry for the + function is shown below. In the first line of this Help Desk entry, the ellipses (...) tell us that the + function may take any number of inputs (0 or more).

(+ z ...) -> number
z : number
Returns the sum of the numbers, adding pairwise from left to right. If no arguments are provided, the result is 0.

[1] All numbers in this handout are presented in base 10 notation.
Examples typed in the DrRacket interactions window are shown below, where the characters typed to the right of the input prompt > are entries by the user and the following line is the result of computer evaluation of the input:

> (+ 1 2)
3
> (+ 4 5 6.7)
15.7
> (+)
0

B. (Quoted) Symbol Type

Characters that represent quoted symbols: According to the syntax rules of Racket, the character sequences, ’a and ’b, are legal Racket expressions called quoted symbols. A quoted symbol is a sequence of one or more keyboard characters (blank spaces are not allowed), preceded by an apostrophe (’), known in programming circles as a single quote.

The purpose of quoted symbols is to represent things like names, job titles, and so on. Any quoted symbol is also a literal value, meaning that any quoted symbol is in simplest form and evaluates only to itself. If the same symbol is not preceded by a single quote, then it is an identifier symbol that stands for a variable name, a constant name, or that is undefined. Non-quoted identifiers are evaluated as place-holders for data. Without the leading apostrophe, a symbol evaluates to something different, and non-quoted symbols are therefore not a primitive type. The mechanism for attaching non-quoted symbols to data values or to functions is covered in Section IV.

Functions that consume quoted symbols: The functions you’ll use on quoted symbols include the symbol? type checker, the symbol=? equality checker for two symbols, and the symbol→string function that converts a quoted symbol to a string.

A version of the Help Desk entry for the symbol=? function is shown below:

Note that a and b as used below are parameter names:

(symbol=? a b) -> boolean
a : quoted symbol
b : quoted symbol
Returns true if a and b are the same quoted symbol.

Examples:
Note that a and b as used below are literal arguments substituted for parameters:

> (symbol=? ’a ’b)
false
> (symbol=? ’cat ’cat)
true

C. Image Type

Representation of images: DrRacket provides us the ability to insert various types of images (e.g., .jpg, .gif files) directly into our programs by choosing “Insert Image...” from the Insert menu and then navigating to the directory where we have the image stored and selecting from that directory the image we want to insert. An image is not represented by characters, it is a picture included in your program.

Images can only evaluate to themselves, so evaluating an image returns the same image. We can also manipulate and name images in Racket programs. Images have parts that you can access, such as width and height.

Functions that consume images: Examples of functions that consume images include image-height, image-width, empty-scene, beside, scale, above, and place-image.

A version of the Help Desk entry for the image-width function is shown below:

(image-width i) -> exact non-negative integer
i : image
Returns the width of i.

Examples:
> (image-width (ellipse 30 40 "solid" "orange"))
30
> (image-width (circle 30 "solid" "orange"))
60
> (image-width (beside (circle 20 "solid" "orange")
 (circle 20 "solid" "purple")))
80
> (image-width (rectangle 0 10 "solid" "purple"))
0

Look up the Help Desk entries for ellipse, circle, beside, and rectangle and see if you can figure out how to call
these functions with various arguments in the DrRacket Interactions Window.

D. Boolean Type

Characters that represent booleans: According to the syntax rules of Racket, the character sequences, true (or #t) and false (or #f), are legal Racket expressions.

The keywords true and false, and their equivalent abbreviations #t and #f, respectively, are literal boolean values.

Functions that consume booleans: To check if two boolean expressions are the same, there is a boolean=? equality checker function that consumes two boolean expressions, returning true if they are equal and false otherwise. There are also logical operators designed to consume and produce booleans: and, or, and not.

A version of the Help Desk entry for the not function is shown below:
(not v) -> boolean
v : boolean
Returns #t if v is #f, #f otherwise.

Examples:
> (not #f)
#t
> (not #t)
#f

E. String Type

Characters that represent strings: Syntactically, strings in Racket are sequences of keyboard characters, sometimes including spaces, bounded by quotation marks (often called double-quotes). For example, “hi there” and “Howdy!” are character sequences that denote string data.

Strings are stored as indexed sequences of characters. For example, the string “Hello world!” could be envisioned as being stored and indexed as shown below:

| Index: 0 1 2 3 4 5 6 7 8 9 10 11 |
| H e l l o w o r l d ! |

Fig. 1. Conceptual storage of string “Hello world!” Note that the position with index 5 contains a space character.

The index numbers for characters in a string start at 0. This is a conventional practice in computer science. Starting the index at 0 is known as zero-based indexing. Later, you will discover how to access and manipulate characters in a string using their index number.
Functions that consume strings: A large number of programs are written to process strings, so we will devote part of the semester to reading and writing functions that consume strings. Almost any sequence of keyboard characters enclosed in quotation marks are literal string values. Note in particular that any space inside quotation marks is treated as a blank part of the string.

The following Interactions Window session demonstrates that the evaluation function behaves like the identity function when applied to string data, meaning that strings evaluate only to themselves. The evaluation function is executed in the Interactions window whenever the user presses return.

> "hi"
"hi"
> "Howdy!"
"Howdy!"

There are many useful primitive functions that consume strings. Most primitive functions for strings have self-explanatory names. For example,

- **string-length** consumes a string str and produces a number representing the length of str.
- **string-append** consumes any number of separate strings and joins them together, in order from left to right to produce a single string.
- **string-ref** consumes a string str and a positive integer i, and returns the character that occurs in str at position i.
- **substring** consumes a string and one or two numbers specifying indices and produces the string from the first index onward or from the first index to one less than the second index.
- **string** consumes any number of characters and produces the characters in a string.

A version of the Help Desk entry for the **substring** function is shown below:

(substring str start [end]) -> string?
str : string
start : exact-nonnegative-integer
end : exact-nonnegative-integer

Returns a new string that is end minus start characters long, and that contains the same characters as str from start, inclusive, to end, exclusive. The [] around end mean that this number is optional, in which case the function returns the substring from start to the last character of str.

Examples:
> (substring "Apple" 1 3)
"pp"
> (substring "Apple" 1)
"pple"

The **substring** function takes at least 2 and at most 3 arguments. The number of arguments is specified in the function definition.

F. Character Type

Characters that represent single characters: A character in Racket is preceded by hash-backslash (#\). For example:

   #\a  →  the letter a
   #\H  →  the letter H

You’ll use character data later in the semester, when you write functions that process character sequences (also known as strings). Any character, such as the letter c, written as #\c, is a literal value and can only evaluate to itself.

Functions that consume characters: Primitive functions that consume characters include **char-upper-case?**, **char-lower-case?**, **char-numeric?**, **char-upcase**, and many more.

A version of the Help Desk entry for the **char-upcase** function is shown below:

(char-upcase ch) -> char?
ch : char
Produces a character that is the uppercase version of ch. If ch has no uppercase version, char-upcase produces ch.

Examples:
> (char-upcase #\a)
#\A
> (char-upcase #\%)
#\%
> (char-upcase #\B)
#\B

The notation (i.e., the hash-backslash) for characters is rather strange. It is important to remember that #\a is not the same as "a". The first expression is the character a and the second expression is the one-character string a. When characters are combined to form strings (covered in the last subsection), the hash-backslash before each character is omitted. You will see that there are functions to convert strings into sequences of characters, and vice versa.

G. Void Type and Side Effects
A “no value” value. Created by a function call that returns nothing and only has a side-effect.

Side-effects include:
1) printing text to the screen,
2) drawing images to the screen, and
3) defining variable and function names.

Several of the output functions whose purpose is to print to the screen (e.g. printf, display, and newline) have a return type of void. Special forms to be covered in subsequent chapter of these notes, such as define and set! are also statements that return void.

It is important to remember that the void data type is not the same as the empty list. A void data type is generated by a function that has only side-effects.

Function that consumes void: There is a type-checker, void? that can be used to recognize the void data type. Look it up in the help desk.

H. Built-in Function Names
Characters that represent functions: All programming languages provide functions to perform basic operations (e.g., addition, subtraction, multiplication and many more). The existence of these functions allows you to use them in your own code to produce new, previously unavailable functions. Just try to think what it would be like to write the code to do addition of two numbers...you would need to know very intricate details of how the computer represents and stores numbers. Further complication arises from the fact that these details vary from one machine to another. Fortunately for us, most simple operations are already available for use when we start learning to program and we just need to know how to look them up and use them.

Racket includes a variety of built-in functions that are identified by unique character sequences and never preceded by an apostrophe. It is important to realize that a primitive function is a Racket datum, just like numbers and booleans. The difference is that functions may consume data of any valid type and may produce output of any valid type. The majority of the primitive functions are written to consume a particular data type, and most do not work on every data type.

Functions in Racket are very similar to functions in mathematics, in that they consume data as input and produce data as output. Functions may also be called procedures or subroutines.

There are different ways to look up the name and usage of a particular function in DrRacket. These are listed in section III-D. The functions you write will frequently use one or more primitive functions to produce more complex functions tailored to specific tasks.
One skill that you will need to develop quickly is interpreting the explanations of functions in the DrRacket Help Desk (under the Help menu). For example, if you look up the \texttt{sqrt} (for square root) function in the Help Desk, you will see something like the following:

\begin{verbatim}
(sqrt z) -> number  
z : number  
Returns the principal square root of \(z\).
\end{verbatim}

Examples:
\begin{verbatim}
> (sqrt 4/9)  
2/3  
> (sqrt 2)  
1.414213562370951  
> (sqrt -1)  
0+1i
\end{verbatim}

The first line of the \texttt{sqrt} entry tells us how the \texttt{sqrt} function is called, that it consumes one argument (\(z\)), and what type of value is returned. The second line says that the argument \(z\) must be a number. The third line explains the purpose of the function. Under Examples we are shown what occurs in the Interactions Window if the \texttt{sqrt} function is called with different arguments.

\textit{Functions that consume functions}: There are primitive functions that consume other functions. These are called “higher order” functions and we will cover them in Section ??.

\textbf{I. Empty List Type}

\textit{Characters that represent empty lists}: According to the syntax rules of Racket, the character sequence consisting of an apostrophe, followed immediately by a left and then a right parentheses, ‘(), is a legal Racket expression.

According to the semantics of Racket, ‘() denotes the \textit{null datum}, which is also called the \textit{empty list}. This datum is also represented by keywords \texttt{empty} and \texttt{null}.

The empty data type includes only this one datum, but it is a very important and frequently used datum because it allows us to detect when we have processed all the items in a non-empty list.

\textit{Functions that consume empty lists}: The primitive functions used most often with the empty data type are the type checker functions \texttt{empty?} or \texttt{null?}. These functions return true only if their argument is an empty list.

A version of the Help Desk entry for the \texttt{empty?} function is shown below:

\begin{verbatim}
(empty? v) -> boolean  
v : list  
The same as (null? v). Returns #t if v is the empty list.
\end{verbatim}

Examples:
\begin{verbatim}
> (empty? '(1 2))  
#f  
> (empty? '())  
#t
\end{verbatim}

\textbf{J. Non-empty List Type}

A non-empty list is, as the name suggests, a set of parentheses enclosing other Racket data types or defined symbols. In many languages, the basic aggregate data structure is called an \textit{array}. In Racket, the basic aggregate data structure is the \textit{list}.

Lists that are containers of data are written as sequences of objects separated by spaces, surrounded by parentheses and preceded by a single quote. For instance, ‘(1 2 3 4 5) is a list of five numbers, and ‘(“this” “is” “a” “list”) is a list of four strings. Lists need not contain only one type of object, so ‘(4.2 “hi” #f) is a valid list containing a number, a string, and a boolean. Lists may be nested (may contain other lists), so ‘((1 2) (3 4)) is
a valid list with two elements, each of which is a list of two elements. Notice that the inner lists do not need to be preceded by single quotes. All symbols and lists inside a quoted list are treated as if they are also quoted.

There are three types of legal non-empty lists:

1) A left parentheses that is NOT preceded by a single quote represents a function call if the first item after the open left parenthesis is a defined function name. Example character sequences that represent functions: +, -, *, /, sqrt, expt, string-append, string-length, image-height, and many more.

2) A left parentheses not preceded by a single quote can represent applications of special forms if the first item after the open left parenthesis is a special form (also know as a keyword). Example special form keywords include: define, lambda, cond, else, if, local, and more.

3) A left parentheses preceded by a single quote is a data container called a list. Example character sequences that represent lists that are data containers were given at the beginning of this subsection and include: ‘(1 2 3), ‘(“Hello” “world”), ‘(abc def ghi), and infinitely many more. Primitive functions that consume quoted lists include first, rest, list?, empty?, length, reverse and list-ref. Primitive functions that produce lists include cons and list.

A left parentheses not preceded by a single quote but followed by the function list is the same as a left parenthesis preceded by a single quote. For example, ‘(1 2 3) is equivalent to (list 1 2 3).

Any list that does not fit into one of the three types listed above is treated as an error. So be very careful where you use parentheses in a Racket program. If you include too many parentheses or put them in the wrong place, you will get an error and your code will not run.

A version of the Help Desk entry for the first function is shown below:

(f first lst) -> any valid type
lst : list

 Produces the first element in a non-empty list.

Example:
> (first ’(1 2 3 4 5 6 7 8 9 10))
1
> (first (list "Hello" "world"))
"Hello"

We will look at each of the three types of non-empty lists as we start using them. Non-empty lists are the major building block of every Racket program. In fact, Racket programs are composed entirely of lists!
III. WRITING PROGRAMS IN DRRACKET

In this class, you will use the software package called DrRacket. DrRacket is free and can be downloaded (see the link on the course web page; sect. 6.x is the most recent version) and installed on any computer. DrRacket is an example of an “Integrated Developer’s Environment” (IDE), so called because it provides facilities for typing programs, saving the typed programs, running the saved programs, and testing the results of running the programs, all in the same window. You will type and run your programs in DrRacket and it will be available for use on any of the machines in the CS department. The prologue of How to Design Programs, 2nd edition contains examples of interactions with DrRacket.

![DrRacket Startup Screen](image)

Fig. 2. A DrRacket startup screen. The top window is called the Definitions Window and the bottom is the Interactions Window. The language is selected by pulling down the Language menu or using the drop-down menu in the lower left corner of the window.

Fig. 2 shows the DrRacket startup screen. The top window is called the Definitions Window and the bottom is the Interactions Window (these windows may be shifted to be displayed side-by-side by choosing Use horizontal layout from the View menu). To toggle the view between only the Definitions Window and the both windows, type CTRL-E or Command-E. To toggle the view between only the Interactions Window and the both windows, type CTRL-D or Command-D.

The DrRacket Interactions Window simulates the operation of a computer that understands expressions typed line by line using the Racket programming language. This enables you to interact with the simulated computer by pressing return. In effect, you use the DrRacket Interactions Window as a communication medium between yourself and the simulated computer.

The DrRacket Definitions Window is used to store lines of expressions that may together form a program or that may just be definitions and invocations of unrelated functions. You must use the Definitions Window to type and save your program. The Interactions Window is only used for trying out expressions and function calls.

When you first open DrRacket, there will be no language chosen. You should pull down the Language menu, select “Choose Language...”, click on “Advanced Student”, and click OK. You must then press the “Run” button to make the
new language the active language for your session.

Before starting a detailed discussion of the DrRacket IDE, you need to know a little more about how expressions are evaluated in DrRacket.

A. Expression Evaluation

Evaluation is the most important thing that DrRacket does—it converts Racket expressions to their simplest form. Because of this, it is important to carefully describe the evaluation process. The good news is that the process of evaluation can be described easily.

You’ve seen that a variety of character sequences (e.g., 34, 'xyz, '() and #t) constitute legal expressions according to the syntax rules of Racket. In addition, you’ve seen that each legal expression denotes a piece of data of a particular kind. For example, 34 denotes the number thirty-four, 'xyz denotes the quoted symbol xyz, '() denotes the empty list, and #t denotes the boolean value true. The character sequences we type are expressions; the data they denote belong to the universe of Racket data. As programmers, we type character sequences; the computer deals with the corresponding Racket data.

Evaluation (often called eval in these notes) is a function that takes one Racket datum as its input, and generates another Racket datum as its output, as depicted in Fig. 3.

![eval function](image)

Fig. 3. A conceptual depiction of DrRacket evaluation. Picture courtesy of Prof. Hunsberger.

The result of evaluation depends on the type of data that is being evaluated.

![eval function](image)

Fig. 4. Input of the number two and the boolean true to the eval function. Picture courtesy of Prof. Hunsberger.

The eval function is not directly available for us to use in the teaching languages (like How to Design Programs Advanced Student), but you can consider it as a function applied by DrRacket during program execution (or whenever you type something and press return in the Interactions Window.)

B. The Global Environment

In Racket, non-quoted identifiers are used as variable names, which are place-holders for actual values. In math, constants like pi and e have values associated with them, so this concept should not be too surprising.

The evaluation of identifier symbols is different from the evaluation of primitive Racket types. In particular, non-quoted symbols do not evaluate to themselves; instead, they evaluate to the value that is associated with them in the
**global environment.** The global environment is a table that contains many entries. Each entry pairs a symbol with its corresponding value (a valid Racket type). To evaluate an identifier, the evaluation function looks up the value associated with that identifier in the global environment.

The evaluation of every identifier is based on table lookup. Each entry in the global environment pairs an identifier with its corresponding value (which is a legal Racket type), as shown in Fig. 5. The global environment is populated by over 200 entries, even before you make any entries of your own.

![Global Environment Table](image)

Fig. 5. Conceptual depiction of the table lookup provided in DrRacket (the global environment), with a column for identifier names and a column for values associated with the names. Note that table shown is empty. This is slightly misleading because the global environment always contains a set of primitive identifiers and their values.

In Racket, unquoted symbols (character sequences that start with a letter and contain no spaces, generally referred to as identifiers) are used as variables. In math, variables frequently have values associated with them so that the variable is actually a placeholder for a particular value. For example, the variable $x$ may stand for the value 3. For this reason, the evaluation of symbols is different from the evaluation of primitive types. In particular, symbols typically do not evaluate to themselves; instead, they are looked up in the global environment.

The Racket datum associated with an identifier in the global environment can be of any valid type. Thus, it might be that the boolean `true` is associated with the identifier `pq`. Similarly, the empty list might be associated with the identifier `my-empty-list`.

In Section IV, you will learn how to add symbols to the global environment.

If an identifier does not have a corresponding entry in the global environment, it is not possible to evaluate that identifier. Attempting to evaluate an identifier whose name is not written in the global (or local) environment will cause an error. When we cover the `define` special form in Section IV-A, you’ll see how to insert new entries into the global environment, thereby enabling you to create and use variables and functions of your own. And that’s called programming (so much fun)!

A global environment is created every time you start DrRacket. This table is stored in the computer’s memory and is not available for you to read. Initially, the global environment contains only the built-in function names and named variables.

### C. Evaluation of Primitive Data

You can use DrRacket to enter character sequences (i.e., expressions) into the Interactions Window and then examine the results reported after evaluation. If you type in an expression that is already in simplest form, you will see the character sequences you type next to the prompt (> ) and those reported back by DrRacket on the following line. If the character sequence you type is undefined, you will see a red error message on the following line.

In the Interactions Window, DrRacket uses the > character to prompt for input. Everything following the > character in the examples shown was typed by a programmer. The text on the lines that do not start with > is that generated by DrRacket in response to evaluation of the character input sequence. Thus, the excerpt from the Interactions Window shown below displays seven separate interactions and demonstrates that numbers, booleans, quoted symbols, strings, the empty list, and the function + all evaluate to themselves, but undefined identifiers (like x) cause an error to occur:
> 3
3
> #f
#f
> 'cat
'cat
> "computers rock"
"computers rock"
> +
+
> x
x: this variable is not defined

The first five examples shown above are primitive types in simplest form. The fifth is looked up in the global environment and echoed back, showing the addition operator is defined. The last example, \( x \), is undefined.

One way to determine if a symbol name has already been entered into the global environment is to type it (unquoted) in the Interactions Window. Remember, if the name is preceded by a single quote (‘), then the name is considered to be a quoted symbol and it will not be looked up in the global environment, nor will it be evaluated. If there is a value associated with the unquoted name in the global environment, the value will be printed, and if there is no value associated with that name, an error like the one shown above for variable \( x \) in the example above will occur.

D. Evaluation of Primitive Functions

As mentioned previously, DrRacket includes a variety of primitive (or built-in) functions. Examples include addition, the subtraction, the multiplication, and many others. It is important to realize that each primitive function is a Racket datum, just like numbers and booleans, and they evaluate to themselves.

For each identifier associated with a built-in function, there is an entry in the global environment that pairs that unique identifier with the function. Therefore, the evaluation of only that particular symbol can be used to gain access to the corresponding function. As mentioned previously, the existence of primitive functions can be confirmed by typing characters like the following in the Interactions Window: (the > is the prompt in the Interactions Window).

```
> +
+
> -
-
> *
*
```

This excerpt shows that, in DrRacket, functions evaluate to themselves. Once you learn how to create Racket functions of your own design in Section IV-A, you’ll be able to give your new functions names by placing appropriate entries into the global environment.

E. Evaluation of Mathematical Expressions

You can use the Interactions Window like a calculator. There are many built-in functions that can be applied to various kinds of input in this window. Each built-in function has a name that follows naming conventions and for each built-in function there is an entry in the global environment that links a particular symbol to that function. The following examples give an overview of how functions are written and applied in mathematics and relates this to how functions are applied in DrRacket.

**Example:** In a math class, you might see a function defined using an equation such as \( f(x) = x \times x \). In this case, the name of the function is \( f \), and we might casually describe it as the squaring function—because for each possible input value, \( x \), the corresponding output value is the square of \( x \) (i.e., \( x^2 \)).
Notice that the definition of the function, \( f \), gives a prescription for generating appropriate output values should \( f \) ever happen to be applied to any input values. In particular, the definition of \( f \) includes an input parameter, \( x \), which is used to refer to potential input values. In addition, the expression, \((x \times x)\), on the right-hand side of the equal sign, indicates how to compute the corresponding output value for any given value of \( x \). The expression on the righthand side of the equal sign is sometimes referred to as the body of the function.

If you wanted to know the output value generated by \( f \) when given 3 as its input, you could get the answer by first substituting the argument 3 for each occurrence of the parameter \( x \) in the expression, \((x \times x)\), yielding \((3 \times 3)\). Evaluating the expression, \((3 \times 3)\), would then yield the desired output value, 9. Similarly, if you wanted to know the output value generated by \( f \) when given the input argument 4, you would first substitute the argument 4 for each occurrence of the parameter \( x \) in the expression, \((x \times x)\), yielding \((4 \times 4)\), which evaluates to 16.

**Another Example.** In the preceding example, the function \( f \) took a single input value. However, you can similarly define functions that take multiple inputs. For example, the function, \( g \), defined below, takes two inputs, represented by the input parameters \( w \) and \( h \):

\[
g(w, h) = w \times h.
\]

Function \( g \) can be used to compute the area of a rectangle whose width is \( w \) and height is \( h \). To apply this function to the input arguments 3 and 7, you first substitute the argument 3 for the parameter \( w \) and the argument 7 for the parameter \( h \) in the expression, \((w \times h)\), yielding \((3 \times 7)\). Evaluating this expression results in the desired output value, 21.

Racket functions behave in a very similar manner to mathematical functions, with input values called arguments substituted for parameters in the body of the function.

**Prefix vs. Infix Notation**

Typing a function name after an open parenthesis and substituting arguments for parameters is known as calling or invoking the function on the input arguments. In Racket, all function calls are written using prefix notation, where an open parenthesis precedes every function identifier and the function identifier precedes the argument(s). This notation is discussed below.

When a function is called:
- the name of the function is preceded by a left parenthesis,
- the name of the function is followed by one or more spaces, then the input argument(s) to the function, each separated by one or more spaces,
- each argument is evaluated and substituted for the corresponding parameter in the function definition, and
- evaluation ends with a right parenthesis.

This notation is different from what you are used to from math classes, where an operator usually occurs between its operands (known as infix notation). Below are some examples of infix expressions and the equivalent prefix expressions:

<table>
<thead>
<tr>
<th>Infix Expression</th>
<th>Equivalent Prefix Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 + 4 * 5</td>
<td>(+ 2 (* 4 5))</td>
</tr>
<tr>
<td>(2 + 3)/5</td>
<td>(/ (+ 2 3) 5)</td>
</tr>
<tr>
<td>2 + 3/5</td>
<td>(+ 2 (/ 3 5))</td>
</tr>
</tbody>
</table>

When writing an expression using prefix notation, it is critical to maintain whitespace between operators (functions) and operands (arguments). The spacing is exaggerated in the table above to emphasize the importance of some blank spaces in these expressions.

An advantage of using prefix notation is that in this type of expression functions can take more than two arguments. For example, consider the infix expression \(1 + 2 + 3 + 4 + 5\). We could convert this to the prefix expression
Another important feature of expressions in prefix notation is that the expressions are evaluated from the inside out. That is, the leftmost expression that contains no sub-expressions, is evaluated first. Consider the prefix expression

\[ (+ 2 (* 4 5)) \]

In this expression, the \((* 4 5)\) is evaluated and then the result of that evaluation is added to 2.

There are many primitive Racket functions that can consume any number of input arguments and you will learn to find such functions in the DrRacket Help Desk.

You should familiarize yourself with the process of converting infix to prefix expressions. Here’s a step-by-step technique from the book *Picturing Programs: An introduction to computer programming* by Stephen Bloch, that may help in translating an expression in "standard" infix algebraic notation into Racket’s prefix notation:

1) Expand all the abbreviations and special mathematical symbols. For example, \(3x\) really stands for \(3 * x\); \(x^2\) really stands for \(x * x\); and \(\sqrt{3x}\) uses a symbol that we don’t have on the computer keyboard, so we’ll write it as \(\text{sqrt}(3 * x)\).

2) Fully parenthesize the expression resulting from step 1, using the usual order-of-operations rules (PEMDAS: parentheses, exponents, multiplication/division, addition/subtraction, in decreasing precedence).

By the end of step 2, the number of operators, the number of left parentheses, and the number of right parentheses should all be equal. Furthermore, each pair of parentheses should be associated with exactly one operator and its operands, so that for any operator, you can point to its enclosing left- and right-parenthesis.

3) Move each operator to a position immediately to the right of its closest enclosing left-parenthesis, leaving everything else in the same order. In particular, make sure all the operands are in the same order in the resulting prefix expression as they were in the given infix expression.

**Example 1:** Write a Racket expression to represent the arithmetic expression \(3x - 4 + 5\).

**Solution:** In step 1, we insert a * between the 3 and the x to get \(3 * x - 4 + 5\).

Step 2 tells us to “fully parenthesize, using order of operations”. Since multiplication has higher priority than addition or subtraction, we rewrite the expression as \(((3 * x) - 4) + 5\). Note that there are three operators (*, +, and −), three left parentheses, and three right parentheses in this expression, as required.

In step 3, we move each operator to the right of its corresponding left parenthesis, to get \((+ ((- (* 3 x)) 4) 5)\), a correct Racket expression in prefix notation.

**Example 2:** Write a Racket expression to represent the arithmetic expression \(7x - \frac{(3+x)}{(y+2)}\).

**Solution:** Step 1 expands the \(7x\) to \(7 * x\).

Step 2 adds parentheses around the entire fraction, around \(7 * x\), and around the whole expression, to get \(((7 * x) - ((3 + x)/(y + 2)))\). Note that there are now five operators (*, −, +, /, and +), five left parentheses, and five right parentheses, as required.

Step 3 moves each of the five operators immediately to the right of its corresponding left parenthesis. We can read this from left to right to get \((- (* 7 x)/( (+ 3 x)(+ y 2)))\), the expression in prefix notation.

**Different ways to look up functions that are available in DrRacket:**

\( (+ 1 (+ 2 (+ 3 (+ 4 5)))) \) or \( (+ (+ (+ (+ 1 2) 3) 4) 5) \), but, since + can take more than two arguments in Racket, you can write the original expression more succinctly as \((+ 1 2 3 4 5)\).
1) You can search a list of available functions by pulling down the Help menu and choosing Help Desk. Then click on the How to Design Programs Languages link. Next, scroll down to section 5 and click on “Advanced Student”. Scroll down again until you see links to the predefined functions listed down the left side of the page, grouped according to the type of data they consume.

2) If you think you know the name of a function, type the function name in the Interactions Window and press enter. If the function is defined, its name will be displayed, meaning the function name is defined and has evaluated to itself. Then you can look up the usage of the function as described in step 3. If the function is not defined, an error message will be displayed.

3) Once you know the name of the function, you can pull down the Help menu, choose Help Desk, and then type the function name at the top of the first Help Desk screen, following the links to the function description.

Note that looking up a function as described in step 1 will also find the particular usage of a function (i.e., what data type the function consumes and what type it produces). Finding a function name using step 2 will only let you know the function exists. Step 3 describes how to look up the input, output, and purpose of an existing primitive function. You should familiarize yourself with looking up functions in the Help Desk by finding the descriptions of all functions introduced in this write-up and in class.

F. Evaluation of Non-Empty Lists (the Default Rule)

Since a non-empty list is a Racket datum, a natural question arises: what kinds of character sequences can the programmer use to denote non-empty lists that are intended to be functions (i.e., what are the syntax rules for expressing non-empty lists when the lists are intended to be function calls)?

As already seen, the empty list evaluates to itself; however, the evaluation of a non-empty, non-quoted list is altogether different. This section presents the default rule for evaluating non-empty lists. Exceptions to the default rule involve keywords and are called special forms. Each special form keyword will be covered as it is needed.

We begin with some examples that confirm something new is happening when DrRacket evaluates non-empty lists whose leftmost element is a primitive function in the Interactions Window:

\[
\begin{align*}
&> \, (+ \, 2 \, 3) \\
&> \, (\star \, 3 \, 4 \, 5) \\
&> \, (+ \, 2 \, (\star \, 3 \, 10)) \\
&> \, (+ \, 2 \, (\star \, 3 \, (+ \, 4 \, 8 \, 6)))
\end{align*}
\]

In each of these examples from the Interactions Window, the expression entered by the programmer is a legal Racket expression in prefix notation that denotes a Racket list. In addition, the evaluation of each list appears to result in an arithmetic computation—in fact, the kind of arithmetic computations you’ve seen in math classes. In each case, the list is being evaluated according to the default rule.

The resulting output datum that appears after typing an expression and pressing return is the result of evaluating the non-empty list given as input. Thus, the result of evaluating the list containing the + symbol, the number two and the number three, is the number five, which DrRacket reports in the Interactions Window using the character sequence 5.

Here’s a summary of this example:

\[
(+ \, 2 \, 3) \quad \rightarrow \quad [\text{list containing + symbol, number two, and number three } \Rightarrow \text{number five}] \quad \rightarrow \quad 5
\]

The evaluation steps (\(\rightarrow\)) are explained by:

1) First Step of Default Rule—look up + symbol in global environment and evaluate arguments 2 and 3:
   + symbol \(\Rightarrow\) addition function
   number two \(\Rightarrow\) number two
number three $\Rightarrow$ number three

2) **Second Step of Default Rule:**
Addition function applied to two and three yields output of five.

Evaluation of all of the items in the list yields the addition function and two numeric arguments. The second step in the default rule involves applying that function to the arguments (i.e., feeding the remaining items as input into that function), as illustrated below:

![Diagram of addition function applied to two and three](image)

There are several advantages to the default rule. First, it only has two steps, and they are always the same. Second, it can be used on arbitrarily complex lists without requiring any modifications.

For example, consider the following evaluation in the Interactions Window:

```
> (+ 2 (* 3 10))
```

The character sequence `(+ 2 (* 3 10))` is a legal Racket expression that denotes a non-empty list. The denoted list contains three items: the `+` symbol, the number two, and a subsidiary list. The subsidiary list contains three items: the `*` symbol, the number three and the number ten. To evaluate this list, you need to use the default rule.

The first step of the default rule requires us to evaluate each item in the list:

1) the `+` symbol $\Rightarrow$ the addition function
   the number two $\Rightarrow$ the number two
   the subsidiary list $\Rightarrow$ WHAT?

Before you can complete the first step of the default rule, you must evaluate the subsidiary list (i.e., the list containing the `*` symbol, the number three and the number ten).

To evaluate the subsidiary list, you need to use the default rule. The first step of the default rule requires you to evaluate each item in the list:

1) the `*` symbol $\Rightarrow$ the multiplication function
   the number three $\Rightarrow$ the number three
   the number ten $\Rightarrow$ the number ten

2) The second step of the default rule requires you to apply the first item (i.e., the multiplication function) to the numbers three and ten. The result is the number thirty.

Now that you know the subsidiary list evaluates to thirty, you can pick up from where you left off when evaluating the original list. The first step of the default rule (for evaluating the original list) requires you to evaluate each item in the list:

1) the `+` symbol $\Rightarrow$ the addition function
   the number two $\Rightarrow$ the number two
   the subsidiary list $\Rightarrow$ the number thirty

2) The second step of the default rule then requires you to apply the first item (i.e., the addition function) to the rest of the items (i.e., the numbers two and thirty). The result is the number thirty-two and Racket returns the character sequence 32.
It is possible for some things to go wrong in the process of evaluating a non-empty list. For example, the function might expect a different number of input arguments than are present in the rest of the original list. Or the attempt to evaluate a datum might be undefined. Or the application of the function to the arguments might be undefined because, for example, the function expects numbers and it is asked to use some other type of data. In any of these cases, the result is undefined and DrRacket would report an error.

For example, none of the following lists can be evaluated under the Default Rule:

- \((1 \ 2 \ 3)\), a list containing the numbers one, two and three
- \((\text{empty} \ \text{empty})\), a list containing two instances of the empty list
- \((+ \ \text{true} \ \text{false})\), a list containing the + symbol, followed by the boolean true and the boolean false

You should try to explain, for each of the lists above, why they could not be evaluated by the default rule. It is important to understand that each of the above lists is a valid Racket datum: each one is a list. It’s just that these lists cannot be evaluated under the default rule (and therefore cannot be evaluated at all).

G. Comments/Documentation

Although we have portrayed the execution of expressions in DrRacket’s Interaction Window, the real place to write code that is saved between times you exit and re-enter DrRacket is in the Definitions Window (at the top or left side of the DrRacket window). All of the programs you write for this class will be written in the Definitions Window and saved in files. To command DrRacket to evaluate code written in the Definitions window, you press the Run button at the top right of the window. The result of running the program is displayed in the Interactions Window.

Comments are used in every computer program as a way to document the purpose of the functions in that program. In Racket, the semi-colon character is used to start a one-line comment. A comment may start at the beginning of a line (in column 0) or anywhere else in a line. Everything on the same line and to the left of a semi-colon should be a valid Racket expression, and everything to the right of the semi-colon is a comment and is ignored by the computer. Comments are easy to see in Racket programs because DrRacket colors them brown.

Comments are as important to computer programs as captions and annotations in a paper or book. For that reason, a significant part of the grade you will receive for a program depends on how well the program is documented.

Another type of comment is made available through DrRacket using comment boxes. To start a comment box, pull down the Insert menu and choose Insert Comment Box. If you have already typed text and you want to comment it out with a comment box, highlight the text, pull down the Racket menu, and choose Comment out with a box. Comment boxes have the disadvantage of making your files much larger, so you may want to stick to semi-colon comments.

H. Indentation, Code Coloring, and Line Length

DrRacket helps you write code by giving indications of when code is written correctly or incorrectly. For example, it colors keywords and function names in blue, literal values in green, comments in brown, and errors in red. DrRacket also indents nested code as it is typed and matches right parentheses with their corresponding left parentheses. You will learn to determine if the code you are writing is correct as you type it by paying attention to the color and indentation, as well as by matching parentheses.

After you have written a function, you can indent it correctly either by choosing “Reindent all” under the Racket menu, or by highlighting the whole function and pressing tab.

In the bottom right corner of the DrRacket window is a pair of numbers separated by a colon (e.g., 67:34). The interpretation of these numbers is that the cursor is currently on line 67 and in column 34. For this class, you will be expected to keep track of the second number in this pair as you are typing programs in the Definitions Window. No line of code or single line comment should extend beyond column 80.

To show line numbers while you type code, pull down the View menu to Show Line Numbers.
IV. Defining Variables and Functions

In DrRacket, there is a set of symbolic expressions called special form keywords. Examples of special form keywords include: and, or, cond, define, else, if, lambda, let, and local. Each of these keywords is a legal Racket expression when used in the proper way.

The interesting thing about special form keywords is this:
⇒ When the first element of a non-quoted, non-empty list is a keyword symbol, then that list is called a special form. And special forms have their own mode of evaluation that does not follow the default rule.

For example, each of the following character sequences denotes a representation of using a special form:

(define x 3)
(if condition then-clause else-clause)
(cond [condition1 return1] [condition2 return2] [else return3])

A special form is evaluated according to a rule that is specific to the keyword used for that special form, not by using the default rule. There is one rule for executing define special forms, another rule for executing if special forms, and so on. Luckily for us, each define special form is executed in the same way, each cond is executed in the same way, and so on. However, the rule for executing the define special forms is very different from the rule for executing the cond special form. In other words, each special form has its own rules for execution.

In the default rule for evaluating non-empty lists, the first thing that happens is that each element of the list is evaluated, one after the other. In contrast, when executing a special form, which is also a non-empty list, some of the elements of that list may not be evaluated. Indeed, the first element of a special form (i.e., the keyword) is never evaluated, nor is it looked up, because no special form is written in the global environment.

In this section, we will introduce the define special form. Other special forms will be covered as we need them.

A. Creating named identifiers in the global environment using define

The purpose of the define special form is to create an entry in the global environment, a side effect. The return type is always void.

As a character sequence, it has the form (define C1 C2), where C1 is an identifier, and C2 can be any expression denoting a Racket datum, call it e.

Evaluating the special form:  (define C1 C2)
C1                                 C2
                                     e  
Global Environment Entry: The symbol C1 E
Evaluating the special form:  (define C1 C2)
C1                                 C2
                                     e  
Global Environment Entry: The symbol C1 E

Fig. 7. Evaluating the special form (define C1 C2).

Only e, the Racket version of the symbol C2, is evaluated (as shown in Fig. 7), the result being some datum E that is written into the global environment. The symbol C1 is not evaluated, but an entry is created in the global environment in which the name C1 is associated with the datum E.

Because define statements generate void output, DrRacket does not display any output on the computer screen when a define special form is evaluated in the Interactions Window, as shown below:

> (define X 6)
>
After the `define` special form is executed as shown above, subsequent attempts to evaluate the symbol `X` in the Interactions Window will result in the display of the value 6, paired with `X` in the global environment, as illustrated in an excerpt from the Interactions Window below:

```
> X
6
> (* X 100)
600
> (* X 1000)
6000
> (* X X)
36
```

When the result of executing a special form generates no output (i.e. return value), we say that the result is a side effect. The side effect of the `define` special form is the inclusion of the symbol name and value in the global environment.

Creating a named value in the global environment is the way to name *global variables* in DrRacket. Similar mechanisms exist to name local variables inside functions. Identifier names allow you to avoid using literal values in code. The usual practice is to start a program with all the variable definitions, such that all identifiers used in the program are written in the same block of code. Any global variable used in the code must be defined *before* it is used. You will see that it is more usual to define variables inside the function in which they are used.

**Example:** Typing the character sequence `(define Y (+ 1 2 3))` into the Interactions Window and pressing return would result in the number 6 being associated with the symbol `Y` in the global environment, as illustrated below.

```
Evaluating the special form:  (define Y (+ 1 2 3))
Y  (+ 1 2 3)  Global Environment Entry: The symbol Y The number six
                              ...                    the numbers one, two, and three
```

Fig. 8. Executing the special form `(define Y (+ 1 2 3))`.

However, DrRacket does not return any output value:

```
> (define Y (+ 2 4 3))
>
```

Subsequent attempts to evaluate the symbol `Y` would result in the value 9, as illustrated below:

```
> Y
9
> (* Y 8)
72
> (* Y 1000)
9000
> (* Y Y)
36
```

The following excerpt from the Interactions Window shows the definition of several constants:

```
> (define WIDTH 500)
> (define HEIGHT 400)
> (define DIAMETER (* 50 50 3.14159))
```

This sequence of interactions would result in setting the name `WIDTH` to be equal to the value 500, the name `HEIGHT` to be equal to the value 400, and the name `DIAMETER` to be equal to `(50 * 50 * 3.14159) = 7853.975`. 
The value of the mathematical expression in the define statement for DIAMETER is written in the global environment after the evaluation of the expression \((50 \times 50 \times 3.14159)\). 

<table>
<thead>
<tr>
<th>Global Environment Entries:</th>
<th>Width</th>
<th>500</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Height</td>
<td>400</td>
</tr>
<tr>
<td></td>
<td>DIAMETER</td>
<td>7853.975</td>
</tr>
</tbody>
</table>

Fig. 9. Adding the symbols WIDTH, HEIGHT, and DIAMETER to the Global Environment.

**Important:** Any usage of the define special form in the Interactions Window will have effect only until the Run button is pressed. Each time the Run button is pressed, all entries made to the global environment in the Interactions Window are rewritten. To make lasting changes to the global environment, you should type the define statements in the Definitions Window and press Run.

**B. Using the define special form to create named functions**

You can also use the define special form to give a function a name. In simple terms, a function is a block of code that accomplishes some task. As a general rule of thumb, each function should perform one specific task. Naming functions is a way of reusing code because one name can result in the application of a name that is usable any number of times in a program.

The following excerpt of an Interactions Window session demonstrates how to name a procedure that produces the cube of a number and then call the function several times:

```lisp
> (define (cube x) (* x x x))
> (cube 5)
125
> (cube 7)
343
> (cube -8)
-512
```

Normally, functions are defined in the Definitions Window so they can be run repeatedly and written to files.

When define is used to add a new function name to the global environment, the identifier is followed by an open parenthesis, the function name, the parameter name, a close parenthesis, and an expression called the body of the function. The body of a function is evaluated when the function is called.

When naming a variable identifier, there is no left parenthesis between the keyword define and the identifier name.

*Additional Example:*

The following Interactions Window session demonstrates how to define, name, and apply a procedure analogous to the function, \(g(w, h) = w \times h\), seen earlier:

```lisp
> (define (rect-area w h) (* w h))
> (rect-area 2 3)
6
> (rect-area 3 8)
24
```

In this example, the function rect-area has two parameters, \(w\) and \(h\). The expression \((*\ w\ h)\) is the body of the function.

Function naming conventions:
Racket adheres to certain conventions for function names.

- Functions that return a boolean (except the relational operators for numbers) end with a question mark (traditionally pronounced “huh”).
- Functions that compare non-numeric types for equality use the name of the type, followed by an equal sign, followed by a question mark. Examples include `string=?`, `boolean=?`, `symbol=?`.
- Functions that convert one type of data to another specify the name of the input type followed by `->`, followed by the name of the output type. Examples include `string->number`, `number->string`, `string->symbol`, and so on.

Distinguishing Arguments from Parameters

An **argument** is a specific value (e.g., a literal value or an expression that evaluates to a literal value) and is given when a function is called. The statement `(rect-area 2 3)` is known as a **function call**. A **parameter** is a “place-holder” introduced in the function definition. A parameter can be thought of as a variable identifier that exists only inside the parenthetical boundaries of a given function. An argument may evaluate to a number, string, image, constant, or any other valid type, but a parameter is always an identifier, a sequence of keyboard characters. For example, the line `(rect-area 2 3)` has arguments 2 and 3 and these numbers are substituted for the parameters `w` and `h` in the expression `(* w h)`.

C. Creating Functions Using the Lambda Special Form

In the last section, you were shown the “short-cut” way to define functions. It is important to know what is really happening when you define functions. Consider the **cube** function, defined as shown in section IV:

```
(define (cube x)
  (* x x x))
```

What the computer sees when this define statement above is executed is:

```
(define cube
  (lambda (x)
    (* x x x)))
```

The Racket family of programming languages provides the **lambda** special form to give us a mechanism to define functions. The **lambda** special form defines everything about a function except its name. Another way of specifying the **lambda** special form is by using the Greek letter `λ`. To insert a Greek `λ` character into a DrRacket program, pull down the Insert menu and choose “Insert λ”. The terms **lambda** and `λ` are used synonymously.

The **define** special form is used to create an entry in the global environment that associates the identifier **cube** with the lambda expression `(lambda (x) (* x x x))`. The only difference between using define to create a variable identifier and using define to create a function is that, when naming a function, the **define** keyword is used to name a lambda expression. When a **define** special form is evaluated, the given symbol—in this case, **cube**—is not evaluated; however, the identifier **cube** and `(lambda (x) (* x x x))`—are written in the global environment under the name and value columns, respectively. Thus, the value associated with the **cube** identifier is the procedure that results from calling the function with a given argument in place of `x`.

Like any special form in Racket, the **lambda** special form is written in a list (a set of parentheses) whose first element is the keyword **lambda**—in this case, either **lambda** (or `λ`). The second element used in a **lambda** special form is the parenthesized parameter list containing the names of the input parameter(s) for the function being defined. The **body** of the function is an expression nested in the lambda expression after the parameter names, in a separate set of parentheses. The parameters and the body are always enclosed in a pair of (possibly nested) parentheses.

Here is an example of a **lambda** expression for a function that calculates the hypotenuse of a right triangle, given side lengths `a` and `b`:
(define hypotenuse
 (lambda (a b)
   (sqrt (+ (* a a) (* b b)))))

The definition above is a lambda form with three parts:
1) The word lambda (or the symbol λ, inserted by pulling down the “Insert” menu and choosing “Insert λ”).
2) The names of the parameters (a and b above), in parentheses.
3) The body is (sqrt (+ (* a a) (* b b))), enclosed in its own set of parentheses.

The following are examples of well-formed (i.e., valid), nameless λ expressions (in this class we will generally define a name for λ expressions). Try typing them in the Interactions Window and they should be identified as procedures.
1) (λ () 44)
2) (λ (x) (* x x))
3) (λ (w h) (* w h))
4) (λ (r h) (* 1/3 3.14159 r h))
5) (λ (x y z) (+ x(- y z)))

X-parameter functions:

We often refer to functions based on the number of input parameters listed in the λ expression. For example, expression 1) above is known as a zero-parameter function, 2) is a one-parameter function, 3) and 4) are two-parameter functions, and 5) is a three-parameter function. If you typed any of these lines in the Interactions window, the result would be a function because functions evaluate to themselves.

In contrast, the following are examples of malformed λ expressions:
1) (λ (x y x) (* x y))
2) (λ (x 10) (* x 10))
3) (λ x)

Take a moment to describe what it is about each of the three expressions that makes them malformed.

The Semantics of a λ Expression:

The semantics of a λ expression stipulates what Racket datum the λ expression denotes, as well as how that Racket datum is evaluated. As suggested by the preceding examples, a λ expression invariably denotes a list—called a λ special form—and the evaluation of that list invariably results in a Racket function. The semantics of the λ expression also includes a description of the subsequent behavior of that function should it ever be applied to any input(s).

Assuming that
- each \( C_i \) denotes a Racket symbol, \( r_i \);
- the symbols, \( r_1, r_2, ..., r_n \), are distinct (i.e., there is no repetition); and
- \( B \) denotes some Racket datum \( D \),
then a λ expression of the form \((λ (\ C_1 \ C_2 \ ... \ C_n \) \ B)\) denotes a Racket list whose elements are as follows:
- the λ symbol;
- a list containing \( n \) distinct identifiers, \( r_1, r_2, ..., r_n \); and
- the Racket datum, \( D \)
This list is referred to as a λ special form.

Calling unnamed λ Expressions:

When you use the default rule to apply a unnamed lambda form to actual input values, it is an invocation or call of the function, as shown below:

\(((\text{lambda} (a \ b) (\text{sqrt} (+ (* a a) (* b b)))) 3 \ 4)\)
Racket evaluates an application involving a lambda form by matching the arguments (3 and 4 above) with the parameters \((a \text{ and } b)\). It then substitutes the arguments for the parameters in the body of the procedure \(\text{sqrt} \ (+ \ (* \ a \ a) \ (* \ b \ b))\). The result is the body rewritten as \(\text{sqrt} \ (+ \ (* \ 3 \ 3) \ (* \ 4 \ 4))\). The lambda keyword tells Racket that this substitution should occur.

The type of a lambda form is a function. The lambda form is the way the programmer expresses that some operations be performed on the arguments and return a value. Racket does not evaluate the elements of the body of the function until the function is invoked (called), on the arguments.

Another example showing how it is possible to define and apply a function without ever having given it a name is given below in an excerpt from the Interactions Window:

\[
> ((\lambda (x) (* x x)) 4)
\]

16

The default rule for evaluating non-empty lists is used to evaluate the expression typed at the > prompt above. In the process, each element of the list is evaluated. The first element of the first subsidiary list is the \(\lambda\) special form, whose body is \((* x x)\). The second element of the list typed at the > prompt evaluates to the number 4. The result of replacing the parameter \(x\) in the body of the function with the input argument 4 yields \((* 4 4)\), which in turn evaluates to the correct output, 16. Later on, we will encounter situations where it is convenient to use functions without naming them, so it is important to understand how to use these unnamed \(\lambda\) expressions.

Summary: The \(\lambda\) special form generates appropriate output values should it ever be applied to any input values. A \(\lambda\) statement includes a list of input parameters and a body (the expression that is evaluated for the return value). A function call progresses as follows:
1) Replace the parameters as they occur in the parameter list of the \(\lambda\) with the arguments on a strict left-to-right basis (in terms of matching the parameter list and the arguments).
2) Evaluate the body from the inside out until all parts are evaluated.

The desired input arguments are substituted for the appropriate input parameters in the body of the function. Next, the resulting expression is evaluated, thereby yielding the desired output value. When unnamed lambda expressions are preceded by a left parenthesis, the evaluation follows the Default Rule. In the following exercise, the value given after the right parenthesis that closes the lambda expression is the input argument (or arguments).

Exercise IV-C-1: Evaluate each of the following Racket forms (try to figure out each of the outputs in your head and then try them on the computer):
(a) \(((\text{lambda}(x) (+ x 2)) 5)\)
(b) \((\lambda (x y) (+ x (* y 3))) 7 4)\)
(c) \((\lambda (x) (((\text{lambda}(y) (* y 2)) (+ x 3))) 4)\)

Exercise IV-C-2: Write lambda forms that express the following algebraic formulas:
(a) \((x - 32) * (5/9)\)
(b) \((x + 3 * y) * (x - y)\)

The most important thing to know about the evaluation of a \(\lambda\) special form is that the result is invariably a function; however, the evaluation of a \(\lambda\) special form only creates the function, you have to apply it to any input(s).

Local vs. Global Environment: When a \(\lambda\) expression is applied to an input value (i.e., when the expression is called with some argument value), a local environment is created for the evaluation of that function. The names in the local environment are the parameter names listed in the \(\lambda\) expression, paired with the values of the arguments to which the \(\lambda\) expression is applied.

Example—Applying the Squaring Function to Input Values: Consider the \(\lambda\) expression, \((\lambda (x) (* x x))\). As noted above, it evaluates to a Racket function. When this \(\lambda\) function is applied to some input value, say 4, by typing \((\lambda (x) (* x x)) 4\), as shown in Fig. 10, the following things happen:
1) A local environment is set up containing a single entry which associates the value 4 with the symbol x.
2) The expression \((x \times x)\) is evaluated with respect to the newly created local environment. *This means that
   every occurrence of the symbol x is evaluated according to the local environment, not the global environment,
   even if x is also associated with a value in the global environment*. If x is associated with a value in the global
   environment, we say that the symbol x in the local environment *shadows* the symbol x in the global environment.
   The evaluation of \((x \times x)\) therefore yields the result 16.
3) That value, 16, is taken to be the output value that results from applying the \(\lambda\) function to the input value 4.
4) The local environment vanishes after the function returns a result.

Here’s an example of a named function that takes more than one input argument.

```
> (define discriminant
   (lambda (a b c)
     (- (* b b) (* 4 a c))))
> (discriminant 1 2 -4)
20
> (discriminant 1 0 -3)
12
```

Notice that the syntax of Racket allows expressions to occupy multiple lines. This is essential when writing longer
expressions. DrRacket automatically indents sub-expressions following a return to make longer expressions easier to
read. Pressing the tab key while the cursor is at any position on a particular line will automatically cause the current
line to snap to the appropriate amount of indentation *unless there is some error in the syntax or semantics of the expres-
sion before that line*. In general, it is a good idea to press enter before the opening parenthesis of each sub-expression.
V. Displaying Strings within Programs

A. The printf, display, and newline functions

DrRacket includes built-in printf, display, and newline functions that produce void output but have the side-effect of printing to the Interactions Window.

The display function is a 1-parameter function that has a side effect of displaying its string argument to the Interactions Window. The display function interprets the character sequence \n in a special way, as a newline character.

The printf function is an n-parameter function that has the side effect of displaying its string argument to the Interactions Window, but it also allows the inclusion of escape characters in the string at specified positions. The printf function interprets the character sequences, \%, \n, and \A (or \a), in special ways when they are embedded in its first argument—a string. \% and \n are newline characters and \A or \a are placeholders for values after the value has been converted to a string.

B. Using printf with escape characters

The character sequences \n, \%, \A and \a are commonly called escape characters because they cause something other than the exact character sequence they are composed of to be printed.

A call to the display, printf, or newline functions evaluates to void. That’s because the whole point of these functions is their side-effect printing. In reality, Racket provides a special datum that is interpreted as “no value”. This “no value” datum is the void data type. Like any other data type, there is a corresponding type-checker predicate for the void data type. It is called void?. Its use is demonstrated below.

> (void? (printf "hi\n"))
hi #t

In this example, the Default Rule for evaluating non-empty lists is used to evaluate the expression, (void? (printf "hi\n")). In the process, the void? symbol evaluates to the built-in void? function and (printf "hi\n") evaluates to the special no value datum belonging to the void data type. The no value datum is fed as an argument to the void? function, resulting in the output value true, as reported by DrRacket. The character sequence, hi, was printed out as a side-effect of the evaluation of the expression, (printf "hi\n").

The following example excerpt from the Interactions Window demonstrates the use of the printf, display, and newline functions:

> (printf "Hi there!")
Hi there!
> (display "Hi there!")
Hi there!
> (printf "Oh, \A I get it!" 'hey)
Oh, hey I get it!
> (display "Oh, hey\nI get it!")
Oh, hey I get it!
> (printf "First thing: \A,\%second thing: \A\% (+ 2 3) (* 6 7))
First thing: 5,
second thing: 42
> (newline)
>

The newline function is a 0-parameter function that causes a blank line to be printed in the Interactions Window.

The display function causes the string (i.e., its only argument) to be displayed in the Interactions Window such that:

- the quotation marks are omitted and
• each instance of the escape sequence \n is interpreted as a newline character, causing a newline to be printed in the Interactions Window.

The printf function causes the string (i.e., its first argument) to be displayed in the Interactions Window such that:
• the quotation marks are omitted;
• each instance of the escape sequence \% (or \n), is interpreted as a newline character, and thus causes a newline in the Interactions Window; and
• each instance of the escape sequence \A or \a is replaced by a character sequence representing the value of one of the remainder of the arguments to printf, where each argument’s value is printed in order, from left to right, after the initial string parameter. The number of \A as included in the first argument to printf (a string) must match the number of arguments that follow the first.

C. Multiple expressions in Racket function body: The begin special form
In the HtDP languages, the body of a function may contain multiple expressions only if the keyword begin surrounds all the expressions. When a function containing a begin is called, each of the expressions in the body is evaluated sequentially, from top to bottom. The value of the last expression is the only output value for the function. All expressions except the last should therefore generate only side effects.

The following function, called verbose-func, contains multiple expressions in its body. When verbose-func is called, each expression in its body is evaluated, from top to bottom. The first four expressions cause the built-in printf function to be called, thereby generating several lines of side-effect printing in the Interactions Window. However, it is the evaluation of the last expression in the function’s body that generates an output value for the function call.

> (define (verbose-func a b)
  (begin
    (printf "Hi. This is verbose-func!\%")
    (printf "The value of the first input is: \A\%" a)
    (printf "The value of the second input is: \A\%" b)
    (printf "Their product is:\%")
    (* a b))
> (verbose-func 3 4)
Hi. This is verbose-func!
The value of the first input is: 3
The value of the second input is: 4
Their product is:
12
>

Even though printf statements generate only side-effects, we will use them in this class when labeling problems, printing results of function evaluation, learning to debug code, and writing “interactive programs” that require input from the user.

Here are a few more examples of using the printf function in the Interactions Window:

> (printf "Line One!\n Line Two!!\n Line Three!!!\n")
Line One!
Line Two!!
Line Three!!!

> (printf "First ====> \a, Second ====> \A, Third ====> \a\n"  
(+ 4 2) (- 9 6.3) (* 4 100))
First ====> 6, Second ====> 2.7, Third ====> 400

> (printf "A symbol: \A, a string: \A, a boolean: \a\n"  
'I-am-a-symbol
"I am a String!"
(> 4 2))
A symbol: I-am-a-symbol, a string: I am a String!, a boolean: #t

Notice that the escape sequence \A is the same as \a, so they can be used interchangeably. These escape sequences are used as placeholders in the string printed as a side effect. The values that are included in the string should match the number of \a or \A escape sequences in the preceding string.
VI. ASKING QUESTIONS AND MAKING DECISIONS

A function whose output is a boolean (i.e., true or false) is called a predicate. This section describes some of the commonly used, built-in Racket predicates and illustrates their use.

A. Type-checker predicates

Racket includes many primitive data types, discussed earlier. For each primitive or compound data type, Racket includes a primitive function called a type-checker predicate. When a type-checker predicate is applied to some Racket datum, the output is true if that datum belongs to the indicated data type; otherwise, the output is false. Thus, the type-checker predicate associated with the number data type number? outputs true whenever the input argument is a number. Similarly, the type-checker predicate associated with the list data type list? outputs true whenever the input datum belongs to the list data type or is an empty list, and so on.

For convenience, each type-checker predicate has an easy-to-remember name that is the data type followed by a question mark. In other words, for each type-checker predicate there is an entry in the global environment that links a particular data type with that predicate. Thus, those data types can be used to refer to the type-checker predicates. For example, the symbol number? evaluates to the type-checker predicate for the number data type; the symbol boolean? evaluates to the type-checker predicate for the boolean data type; and so on. By convention, we pronounce the symbol number? as “number-huh”. Also by convention, every predicate function name ends with the ? symbol.

Each type-checker predicate is a function that can be applied to a single input (i.e., each type-checker is a one-parameter function). That input can be any type of Racket datum. The type-checker predicates are unique in that they can be applied to any type of input without causing an error, a claim that is not true of the rest of the built-in functions. A type-checker predicate returns true if the given input datum is of the appropriate data type, and false otherwise, as illustrated in the following Interactions Window session:

```
> (number? 3)
#t
> (number? true)
#f
> (boolean? #f)
#t
> (boolean? x)
#f
> (symbol? +)
#f
> (symbol? ’+)
#t
> (procedure? +)
#t
> (procedure? ’+)
#f
> (procedure? 34)
#f
> (list? ’(12 34))
#t
> (list? empty)
#t
```

Notice that the type checker predicate names mirror the names of the corresponding data types, except that the symbol associated with the type-checker predicate for functions is procedure?, not function? and the type-checker for quoted symbols is called symbol?.

Each of the expressions typed at the Interactions Window prompt in the excerpt above denotes a list that is evaluated according to the default rule for evaluating non-empty lists. In each case, the first element of the list is a symbol that evaluates to a function, which is then applied to whatever the second element evaluates to. Notice that the + symbol in (procedure? +) evaluates to the addition function, whereas the ’+ expression in (procedure? ’+) evaluates to the quoted + symbol. Notice too that the list? type-checker predicate returns true for any list, whether empty or non-empty.
B. Arithmetic Predicates: Relational Operators

In addition to the primitive arithmetic functions for addition, subtraction, multiplication and division, Racket includes several arithmetic predicates, such as greater-than, less-than, and equal predicates and each is associated with a particular symbol in the global environment:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>greater than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>greater than or equal to</td>
</tr>
<tr>
<td>=</td>
<td>equal to</td>
</tr>
<tr>
<td>&lt;</td>
<td>less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>less than or equal to</td>
</tr>
</tbody>
</table>

Each of these predicates, when applied to two or more numeric inputs, generates the expected boolean output, as illustrated below.

```
> (> 3 4)
#f
> (> 4 3 1)
#t
> (< 7 5 3 1)
#f
> (>= 4 3)
#t
> (= 3 4)
#f
> (= 3 3)
#t
```

Note that the creators of Racket decided to stick to mathematical convention and did not include a question mark at the end of each arithmetic predicate, even though that is the pattern for most predicate function names.

There are also versions of some relational predicates for non-numeric data types. The use of these relational predicates are demonstrated below:

```
> (string=? "hi" "hello")
#f
> (string>? "zoo" "yellow")
#t
> (symbol=? 'abc 'def)
#f
> (boolean=? (> 4 6) (< 7 2))
#f
```

Booleans and quoted symbols cannot be compared for anything but equality because they are atomic, unlike strings, which can be compared for size and alphabetical order. It is wise to look up the usage of such predicates in the Help Desk before assuming they exist.

C. The Boolean (Logical) Operators: and, or, not

This section introduces the boolean operators, and, or and not. The first two are implemented as special forms in Racket; in contrast, not is a built-in function.

The not Function

The global environment associates the not symbol with a built-in function. When given a boolean value as input, the not function returns the opposite boolean value, as demonstrated below in the Interactions Window:

```
> (not #t)
#f
> (not #f)
#t
```

The and Special Form

In the simplest case, the and special form takes two boolean inputs: (and boolOne boolTwo), where boolOne and boolTwo can be arbitrarily complex expressions that evaluate to true or false.
If both boolean expressions, boolOne and boolTwo, evaluate to true, then the and expression itself evaluates to true. If either boolOne or boolTwo evaluate to false, then the and expression evaluates to false. The following Interactions Window session demonstrates this behavior:

```lisp
> (and #t #t)
#t
> (and (> 3 2) (< 5 9))
#t
> (and #t #f)
#f
> (and (> 3 2) (< 4 6) (= 5 9))
#f
> (and #f #t)
#f
> (and (> 2 5) #t)
#f
> (and #f #f)
#f
> (and (< 2 5) (= 9 (/ 18 2)))
#t
```

The and special form is called a “short-circuiting” function because it can be written to avoid run-time errors. For example, consider the definition of the following function frac that matches an input argument to its parameter $x$ and returns the fraction $\frac{1}{x}$ if $x$ is a non-zero number and $\frac{1}{x} > .4$, returning $(x+1)$ if $x$ is equal to 0 (avoiding an arithmetic divide by zero error):

```lisp
> (define frac
   (lambda (x)
     (if (and (not (= x 0))(> (/ 1 x) .4))
         (/ 1 x)
         (+ x 1))))
> (frac 0)
1
> (frac 1)
1
> (frac 2)
.5
> (frac 3)
4
```

The function frac avoids a “divide-by-zero” run-time error by returning false if $x = 0$ and never executing the second boolean expression $(> (\ / 1 x) .4)$ when $x = 0$.

The and special form, like many of the built-in arithmetic functions, can take more than two input expressions. In such cases, the value of the and expression is true if and only if all of the input expressions evaluate to true, as demonstrated below:

```lisp
> (and #t #t #t #t)
#t
> (and #t #t #f #t #t)
#f
> (and (> 3 2) (= 9 9) (<= 5 20))
#t
```

The or Special Form

The or special form evaluates to boolean true if and only if at least one of the input expressions evaluates to true. The behavior of the or special form is illustrated below:

```lisp
> (or #f #f #f #f)
#f
> (or #f #f #t #f)
#t
> (or #t #t #t #t)
#t
```
Like the *and* special form, the *or* is short-circuiting, meaning it only evaluates its input, from left to right, until an expression evaluates to *#t*, in which case it returns *#t*. 

`> (or (= 9 8) (> 7 9) (<= 4 2))`  
.radix10

*#f*
D. Making Decisions—Special Forms: cond & if

A conditional expression is one whose evaluation depends on the value of a boolean expression—the boolean expression is called the condition. In Racket, a conditional expression can be composed using the if or cond special forms.

Conditional expressions influence what is known as the flow of control in a program. Usually, functions are evaluated line by line, from top to bottom. When a function includes decision statements like if or cond, some lines of code are not evaluated because the statements cause the flow of control to skip over certain lines.

The boolean condition in a conditional expression can be simple or complex. A complex boolean condition can be composed using the and and or special forms, as well as the built-in not function.

Frequently, it is useful to nest one if within another. In such cases, the resulting Racket expression can become quite complex. Thus, Racket provides another special form, the cond special form, to simplify nested conditional expressions.

The evaluation of the if, cond, and or special forms is called lazy or short-circuiting because only the computations needed to ascertain the final value are actually performed. What this means will be discussed along with each special form.

E. The if Special Form: The basic yes/no decision-maker

Syntactically, the strictest version of an if special form looks like this:

\[
(\text{if } \text{boolExpr} \ \text{thenExpr} \ \text{elseExpr})
\]

where:
- boolExpr evaluates to a boolean (i.e., either #t or #f); and
- thenExpr and elseExpr are any Racket expressions.

The semantics of Racket stipulates that an if special form is evaluated as follows:
- First, the boolean expression, boolExpr, is evaluated.
- If boolExpr evaluates to #t, thenExpr is evaluated—and the value of the if special form is whatever thenExpr evaluates to.
- On the other hand, if boolExpr evaluates to #f, then elseExpr is evaluated—and the value of the if special form is whatever elseExpr evaluates to.

The following expressions are examples of using the if special form:
- \((\text{if } (> \ 2 \ 4) \ (* \ 8 \ 2) \ (* \ 6 \ 5))\)
- \((\text{if } (> \ 4 \ 2) \ '\text{then} \ '\text{else})\)
- \((\text{if } \ #f \ "\text{then}" \ "\text{else}"))\)

Notice that boolExpr, the first parenthesized expression after the if, is always evaluated; however, only one of the remaining expressions, thenExpr or elseExpr, is evaluated during a particular execution.

The following Interactions Window session demonstrates the evaluation of the if special forms seen above.

\[
\begin{align*}
&> (\text{if } (> \ 2 \ 4) \ (* \ 8 \ 2) \ (* \ 6 \ 5)) \\
&\quad \text{30} \\
&> (\text{if } (> \ 4 \ 2) \ '\text{then} \ '\text{else}) \\
&\quad \text{then} \\
&> (\text{if } \ #f \ "\text{then}" \ "\text{else}") \\
&\quad "\text{else}"
\end{align*}
\]

In the first expression, the condition, \((> \ 2 \ 4)\), evaluates to \#f. Thus, the else expression, \((* \ 6 \ 5)\), is evaluated. Its value, 30, is the value of the entire if expression.
In the second expression, the condition, (\(> 4 2\)), evaluates to \(#t\). Thus, the quoted symbol \('then\) is returned as the value of the entire if expression.

In the third expression, the condition, \(#f\), evaluates to \(#f\). Thus, the string, “\(else\)”, is the value of the entire if expression.

Using an if expression in the body of a function.

Below, a function, \(howBig\), is defined and run in the Interactions Window. If given a number less than 10 as an input, its output is the symbol \('small\); otherwise, its output is the symbol \('big\) (assuming the input is a number\(^2\)).

\[
> (define (howBig num)
  (if (< num 10)
    'small
    'big))
\]

\[
> (howBig 5)
'small
> (howBig 102)
'big
\]

F. Making Multiple Choice Decisions: The \texttt{cond} Special Form

If there are more than two choices for a decision statement, then it is possible to either nest if statements, or use a \texttt{cond} special form. The \texttt{cond} special form is designed to handle decisions with 2 or more outcomes. For example, consider the following function that consumes a number representing a score and returns a symbol representing the letter grade for that number using a sequence of nested if\(\texttt{s} to make the decisions:

\[
> (define (grader-v1 score)
  (if (>= score 90)
    'A
    (if (>= score 80)
      'B
      (if (>= score 70)
        'C
        (if (>= score 60)
          'D
          'F))))
\]

\[
> (grader-v1 95)
'A
> (grader-v1 75)
'C
\]

The \texttt{grader-v1} function is long enough that it makes more sense to define it in the Definitions Window. This definition is shown below, where the function \texttt{grader-v2} is written using a \texttt{cond} statement instead of nested if\(\texttt{s}:

\[
; (define grader-v2
  (lambda (score)
    (cond
      ; A for score 90-100
      [(>= score 90) 'A]
      ; B for score 80-89
      [(>= score 80) 'B]
      ; C for score 70-79
      [(>= score 70) 'C]
      ; D for score 60-69
      [(>= score 60) 'D]
      ; F for score <= 59
\]

\(^2\)If the input argument is not a number, what do you think the outcome of the function will be?
You should pay attention to the comments before each part of the cond given above. As a general rule, each branch of a decision statement should be preceded by a comment.

The general syntax of a cond special form is as follows:

```
(cond
  [boolExpr1 expr1]
  [boolExpr2 expr2]
  ...
  [else exprelse])
```

where:
- each [boolExpri expri] pair is called a clause;
- each boolExpri is a condition that evaluates to a boolean;
- the condition in the last clause is either else or #t; and
- each expri is some Racket expression.

The value of such a cond expression is determined as follows:
1) The first condition, boolExpr1, is evaluated. If it is true, then the value returned by the whole cond expression is the value of the corresponding expression, expr1 and none of the lines following are evaluated; if boolExpr1 is false, expr1 is not evaluated and the flow of control goes to boolExpr2, and so on,
2) for every boolExpri that evaluates to false, the corresponding expri is not evaluated; and
3) if all the boolExpris have evaluated to false, the exprelse is the return value.

Note that each cond clause starts with a [ and ends with a ]. And since each boolExpr is (more often than not) a function call, this is one of the only expressions you will use that has a [ followed by a (, as shown in the second version of the grader-v2 function above. Braces can be used interchangeably with parentheses in Racket.

G. Using the Stepper to Trace Execution of Functions

It is often advantageous to use a feature in DrRacket called “the Stepper”, to see every evaluation involved in the application of a function. The Stepper is not available in the Advanced Student language or Swindle, but it is available in the language Intermediate Student with Lambda. To run the Stepper, follow these directions:

1) Copy and paste the function (and any constants or helper functions it uses) into a new Definitions Window: To do this, highlight the function, pull down the Edit menu and choose Copy, then pull down the Edit menu to choose New Tab. When your cursor is in the new definitions window, pull down the Edit menu and choose Paste.

2) Choose the language Intermediate Student with Lambda and press Run.

3) Type at least one function call into the new Definitions Window under the function definition and press Run to make sure the function call is legitimate.

4) Press the Step button. You should see the function with all the arguments in the call substituted for the matching parameters. Press Step to go through the evaluation.

Note that some functions in Swindle and Advanced Student language (ASL) are not defined in the Intermediate Student with Lambda (ISL) language. In particular, the printf, display, and newline functions are not defined and function bodies can contain only one expression in ISL.
VII. THE DESIGN RECIPE: A DISCIPLINED APPROACH TO WRITING FUNCTIONS

A. Pre-function Comments

You really can’t write a function to perform some computation if you don’t already know the correct solution to the function for some subset of possible inputs. For this reason, we will follow the convention that every function starts with a group of comments that give the function name, parameter names, output type, argument data types, and function purpose.

Comments make code easier for people to understand. Programs written without comments are often useless to anyone who must later modify the code. For this class, comments are as important as the functions you write. The comments shown below are written before a function that produces the area of a rectangle. First and foremost, every function should have a name, given in the comments, that describes the purpose of the function.

;; (area width height) -> number
;;
;; width and height are numbers
;;
;; Calculates the area of a rectangle given the width and height.

The first line of a comment of this style is called a contract or a signature, and it specifies:
1) the name to use when calling the function (e.g., area),
2) the parameter names (width and height) used inside the function, and
3) the type of output datum produced by the function (to the right of the ->) (e.g., a number).

The next two lines are:
1) the type(s) of data arguments the function takes as input (e.g., two numbers) for placeholders width and height, and
2) the purpose of the function.

The style of pre-function comments used in the “How to Design Programs” books and in the DrRacket help desk look something like this (for the area function):

; (area width height) -> number
; width: number
; height: number
; Calculates the area of a rectangle given
; the width and height.
; Examples:
; > (area 5 4)
; 20

In the Help Desk, the section of on-line documentation that covers the function string-length looks something like this (dashes have been added to separate parts of the comment and are not shown in the HtDP books; also, the headings Contract, Input, and Purpose have been added):

;; (string-length str) -> nonnegative-integer
;;
;; str is a string
;;
;; Returns the number of characters in str.

The contract tells us that the function string-length consumes a string argument for parameter str and produces a non-negative whole number. Next, there is a listing of the input parameter name str and type. Lastly comes the purpose.

Now let’s look up the function string-append. The documentation for this function looks like this:

;; (string-append str ...) -> string
;;
;; str : string
;;
Concatenates the characters of one or more strings.

The ellipses (...) in the contract of the example above tells you that the string-append function can consume any number of string inputs. There are many primitive functions that can take an arbitrary number of inputs, so you should know how to recognize them by the ellipses in their contracts when you encounter them in the documentation.

For this class, you should always precede a function definition with a group of comments consisting of

- **Contract**: A comment that gives the name of the function and the name of each of its parameters inside a set of parentheses, followed by an arrow and then the data type of the value returned. If there are multiple possible types returned, represent the output type as the union of all the possible types, within a set of parentheses.
- **Input**: A listing of the function parameter names and each of their data types.
- **Purpose**: A comment that is a brief but complete statement of what the function computes. Reference may be made to any of the parameter names, since they are already introduced in the previous comments.

After a function is defined, it must be called in order to produce a result. Calling a function requires that the function is already defined. The creators of DrRacket have provided a way for you to write the expressions to test your functions before you write the functions. You can’t run these tests until after you defined the function...but making the effort of thinking of a few concrete cases of using the function almost always help you write the function.

### B. Pre-Function Testing: The check-expect and check-within Special Forms

As an example of testing a function before it is written, suppose you wanted to write the grader-v2 function from Section VI-D. Following the steps in the Design Recipe, we start writing the function with a group of pre-function comments:

```scheme
;; (grader-v2 score) -> quoted symbol
;; score is a number
;; Return a letter grade corresponding to the given score.
```

Now, before writing the actual function definition, we add another step to the Design Recipe—pre-function tests. The general form of a check-expect statement is:

```scheme
(check-expect funcCall funcResult)
```

where `funcCall` is a call of the function to be written and `funcResult` is the value returned by the function.

The pre-function tests are intended to be written before you write the function, to show you know what the function should produce for given inputs and to give you insight into how to write the function.

Writing test statements before you write the function causes you to think about how a problem should be solved. The lines to pre-test the grader-v2 function from section should look something like this:

```scheme
; Pre-function tests:
(check-expect (grader-v2 90) 'A)
(check-expect (grader-v2 80) 'B)
(check-expect (grader-v2 70) 'C)
(check-expect (grader-v2 69) 'D)
(check-expect (grader-v2 5) 'F)
```

Note that there is a separate test case for each branch of execution (each cond clause). Also, note that running the check-expect statements will cause errors until the function definition is written.

You may ask how a function can be called before it is written. The answer is that DrRacket moves every check-expect function call to the bottom of the program prior to running the code. This is why the line telling you how many tests passed always comes up last.
When testing a function, it is necessary to test every *branch* of execution. For example, each clause in a *cond* expression and each part of an *if* execution is a branch of execution and each should be tested separately.

The *check-expect* special form is useful only for computations that produce exact results (e.g., whole numbers, non-repeating decimal numbers, strings, symbols, booleans). There is another form of test statement called *check-within* that can be used to test the result of computations that may be inexact. The general form of a *check-within* special form is:

\[
(*\text{check-within } funcCall\ funcResult\ errorTolerated *)
\]

where *funcCall* is a call of the function to be written, *funcResult* is the value returned by the function, and *errorTolerated* is the amount the actual computed value can be expected to differ from *funcResult*. The *check-within* statements are also run after all function definitions have already been made, even though you write them before writing the function they test.

C. Function definition and parameter naming

After the pre-function testing (if applicable) comes the actual function definition. The examples below put together all the information about the Design Recipe that we have covered thus far.

**Example 1:** Write a function *arrange-name* that consumes 2 string arguments, *first* and *last* representing first and last names, and returns a single string—*last, first*—the last name, followed by a comma and a space, and then the first name:

```scheme
;; (arrange-name first last) -> string
;;
;; first and last are strings
;;
;; Concatenate the input strings as follows:
;; last, first (inserting the , into the output string)
;;
;;Pre-function tests:
(check-expect (arrange-name "Donald" "Duck") "Duck, Donald")
(check-expect (arrange-name "Xena" "Warrior-Princess") "Warrior-Princess, Xena")
(check-expect (arrange-name "Matthew" "Vassar") "Vassar, Matthew")
;
;;Function definition:
(define arrange-name
  (lambda (first last)
    (string-append last ", " first)))
```

**Example 2:** Write a function *pythagorus* to compute the Pythagorean rule:

```scheme
;; (pythagorus a b) -> number
;;
;; a and b are numbers
;;
;; Compute the hypotenuse of a right triangle with
;; sides of length a and b using the formula(sqrt (a^2 + b^2)).
;
;;Pre-function tests:
(check-expect (pythagorus 3 4) 5)
(check-within (pythagorus 2 2) 2 1)
(check-within (pythagorus 1 1) 2 1)
(check-within (pythagorus 5 8) 9 1)
;
;;Function definition:
```
(define pythagorus
  (lambda (a b)
    (sqrt (+ (* a a) (* b b)))))

Notice that check-within is used to pre-test the pythagorus function in the last 3 pre-function tests because the answer in these cases is not an exact number. Check-expect can be used in the first pre-function test because the answer is exact.

We can use any names we like for parameters. Thus, for example, we could have written the pythagorus function as:

(define(pythagorus bob fred)
  (sqrt (+ (* bob bob) (* fred fred))))

However, using random names such as bob, fred, xyzzy, or ghhtj makes the code unnecessarily difficult to read and code that uses parameter names that have meaning to the problem being solved is better.

Always be sure to include enough comments in the definition of a function so that a person with a reasonable amount of programming knowledge can easily determine the purpose of each line in the function. If the function has a decision statement, it is good practice to include a comment prior to each clause, or a comment to split up the clauses for easier reading.

Often, the comment before a function definition says all there is to say about what the function does. But if you have anything further to tell the reader about what a function is doing, be sure to include one or more comments within the code. Comments can be started after a line of code, but be sure no lines in a program are longer than 80 columns, not even comment lines.

D. Post-function printing using the printf function

After writing a program that contains only pre-function tests, all you get to see after running the code is the “All tests passed!” line generated by the check-expect statements. It is somewhat more satisfying to see the function call and also the result of that call. The printf function was covered in Section V-A.

E. Literal values in function definitions

It is considered poor programming practice to include numbers, quoted symbols, strings, and images inside a function definition, although at times it is OK to do so. The next section shows how to define names for literal values.

An example function that uses too many literal values is the grader-v2 program from Sect. VI-F. After this program is written, it is conceivable that the cut-offs for each letter grade could change and it is even possible that the grade designations could change. For these reasons, it is better to precede the function with constant definitions as shown below in the grader-v3 procedure below. This example shows how the printf statements are used inside a function definition.

; Contract: (grader-v3 score) -> quoted symbol
;-----------------------------
; Input: score is a number
;-----------------------------
; Purpose: Consumes a numeric score between 0 and 100
; and returns a symbol representing the grade.
;
; Side-effect is printing a comment and returning
; the grade.
;
;Pre-function tests:
(check-expect (grader-v3 98) 'A)
(check-expect (grader-v3 88) 'B)
(check-expect (grader-v3 70) 'C)
(check-expect (grader-v3 69) 'belowC)
; Function constant definitions:
(define A 90) ; low score cut-off for A
(define B 80) ; low score cut-off for B
(define C 70) ; low score cut-off for C
(define ASYM 'A) ; representation of highest grade
(define BSYM 'B) ; representation of good grade
(define CSYM 'C) ; representation of average grade
(define DFSYM 'belowC) ; representation of low grade

; Function definition:
(define (grader-v3 score)
  (cond
    ;; ----------------score=90->100----------------
    [(>= score A) ASYM]
    ;; ----------------score=80->89-------------------
    [(>= score B) BSYM]
    ;; ----------------score=70->79-------------------
    [(>= score C) CSYM]
    ;; ----------------score<70---------------------
    [else DFSYM]))

; Post-function tests:
(printf "(grader-v3 90) should be \"A\" and is \"a\n\n\"
  'A
  (grader-v3 90))
(printf "(grader-v3 89) should be \"B\" and is \"a\n\n\"
  'B
  (grader-v3 89))
(printf "(grader-v3 79) should be \"C\" and is \"a\n\n\"
  'C
  (grader-v3 79))
(printf "(grader-v3 60) should be \"belowC\" and is \"a\n\n\"
  'belowC
  (grader-v3 60))

The grader-v3 procedure uses seven global variables that are defined before the function definition. These variables are used in the procedure in place of their literal values. In the grader-v3 function, both numbers and quoted symbol literals are declared as constants before the function definition. Note that the constant names are defined in the global environment when the program is run and can be used anywhere inside the function definition or in subsequent definitions in the same program file.

Small constants such as 0 and 1 are frequently used directly in code. But most literal values should be declared as global variables outside the code, along with comments explaining the reason for creating these variables.